


Comparison of Chlorophyll-a Retrieval from Aqua MODIS Using SeaDAS and ArcGIS of Visakhapatnam coast at Bay of Bengal


Abstract
This study compares the performance of SeaDAS and ArcGIS in extracting DN values of Chlorophyll-a (Chl-a) zonal statistics from Aqua-MODIS satellite imagery for the coastal waters of Visakhapatnam, Bay of Bengal, spanning January to December 2024, using buffer zones of 50km,75km,100km,125km,150km and 200km radii from the Visakhapatnam fishing harbor. This analysis reveals high consistency between the two tools, with absolute errors ranging from 0.000027 to 0.002961 mg m⁻³ and Absolute Percentage Errors (APE) from 0.000001 to 0.120614. Errors were negligible up to 150 km but increased slightly at 200 km buffer due to a recurring one-pixel discrepancy. Both tools proved reliable for delineating potential fishing zones, with errors well below ecologically significant thresholds. SeaDAS, an open-source tool, excelled in precise processing of Net CDF data, while ArcGIS, requiring format conversion to Geo TIFF, offered superior geospatial visualization and multilayer analysis.
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1. Introduction
Remote sensing has various applications in the marine ecosystem, particularly in the estimation of Sea Surface Temperature (SST), Chlorophyll-a (Chl-a), and suspended sediment concentration (Devi et al., 2015). Chl-a is a significant parameter to quantify phytoplankton biomass and primary productivity in aquatic ecosystems (Das, 2024). Remote sensing facilitates mapping Chl-a concentrations over large spatial scales without physical contact (Alaudin et al., 2024). Aqua-MODIS satellite imagery provides high temporal resolution, which is useful for monitoring the concentration of Chl-a in water bodies, conducting spatiotemporal research and broad-scale water monitoring in fishing grounds (Alianto & Hamuna, 2020, Lu, 2022 and Wibisana et al., 2018). Various methods are available for retrieving the Chl-a values in a buffer zone, which helps to identify specific areas and understand coastal influences that impact marine biodiversity. Over the past decade, SeaDAS has been widely used as a critical tool for atmospheric correction and Chl-a retrieval from satellite ocean color measurements, especially in optically complex waters. Hu et al. (2024) used both the default and MUMM atmospheric correction options in SeaDAS, along with a range of retrieval models, to validate Chl-a variability in the Bohai Sea by the use of GOCI data. Likewise, Le et al. (2013) used SeaDAS to process MODIS data for the development of a long-term Chl-a dataset in a turbid estuary, which facilitated enhanced eutrophication monitoring and support to resource management. In addition, Cao et al. (2022) validated the use of SeaDAS in the validation of Landsat-derived reflectance along with MODIS and HICO data to estimate Chl-a concentrations in Lake Taihu, thus demonstrating its use for long-term time-series studies. For instance, ArcGIS has been used to process Sentinel-2A imagery to enable radiometric correction, calibration, and spatial analysis to generate Chl-a mapping (Kaymaz & Ates, 2018).   ArcGIS version 10 was used to build geodatabases of field and satellite-retrieved Chl-a data, enabling validation using correlation analyses and the detection of systematic biases between remote sensing and in-situ measurements (Kalinka & Vodopianova, 2022). These studies make ArcGIS a multifaceted alternative to SeaDAS, which is beneficial to research with a focus on spatial distribution, geostatistical modelling, and integration with field-based environmental data. The need for this comparison between SeaDAS and ArcGIS stems from the scarcity of studies with a focus on these tools specifically in remote sensing and geospatial application contexts in the retrieval of oceanographic data. This comparative study hopes to fill this research gap by providing an evidence-based comparison of the performance of these computer programs. Through this, it hopes to help researchers in the selection of the most appropriate tool to meet their requirements and enhance the efficiency of data processing and analysis. 
2. MATERIALS AND METHODS 
2.1 STUDY AREA
[image: ]The study area encompasses the coastal waters of the Visakhapatnam district in northern Andhra Pradesh, situated in the Bay of Bengal at approximately 17.695° N latitude and 83.3025° E longitude. This research has established multiple buffer zones extending from the Visakhapatnam fishing harbor, with specified radii of 50 km, 75 km, 100 km, 125 km, 150 km, and 200 km. The Bay of Bengal, recognized as the largest bay globally and a significant part of the Indian Ocean, sustains a rich diversity of marine flora and fauna and contributes nearly 7% of the world's total fish catch (Transboundary Diagnostic Analysis, Volume 2). Consequently, monitoring this region presents a valuable opportunity for delineating fishing zones and forecasting fisheries yields effectively. (Figure 1) Figure 1: Study Area

2.2 SeaDAS (Sea, Earth and Atmosphere Data Analysis System)
SeaDAS is a powerful software package developed by NASA for ocean color data processing, visualization, and analysis, with specific emphasis on Chl-a concentration. SeaDAS supports various satellite sensors like MODIS, MERIS, and SeaWiFS, thus making it convenient for researchers to easily extract and analyse Chl-a data. SeaDAS incorporates atmospheric correction algorithms that are employed to remove the impact of the atmosphere from the sensor signal, thus making it possible to measure the water-leaving radiance accurately (Ginanjar et al., 2025). SeaDAS supports a range of tools that assist users in extracting information about pixel values from satellite data and statistical analysis. SeaDAS also supports standard operational inversion algorithms for Chl-a concentration. Blue-green band ratios are used by OC2, OC3, and OC4 algorithms and are widely used to analyze open ocean water (Ocean biology distributed active archive center, 2017).
2.3 ArcGIS
ArcGIS is a powerful geographic information system (GIS) software that can be utilized for ocean Chl-a concentration analysis and visualization. The software features, e.g., the Image Analysis toolbar in ArcGIS Desktop and the Image Analyst extension in ArcGIS Pro, enable researchers to process and analyze satellite data imagery, e.g., MODIS Aqua, for Chl-a content. ArcGIS also enables overlaying vector data, e.g., coastal district shapefiles, with raster images and the creation of buffer zones to enable the spatial analysis of Chl-a levels within specified coastal districts. The software can handle large datasets, run complex spatial analyses, and produce informative visual outputs, thus making it an ideal tool for ocean color and other marine parameters researchers. (Setiawan et al., 2021, Raja & Kumar, 2023))
2.4 Satellite-derived Chlorophyll-a
Remote sensing of ocean color is employed to quantify Chl-a concentration under the hypothesis that phytoplankton shift the spectrum of backscattered light, from blue to green colors (Dierssen,2010). Satellite sensors like SeaWiFS, MODIS-Aqua and Sentinel-2 have been employed to quantify Chl-a concentration, each with different design parameters and orbital characteristics influencing data acquisition processes (Gregg & Rousseaux, 2014; Johansen et al., 2018). For this research, 12 monthly level 3 Aqua MODIS satellite images (4 × 4 km in resolution) were downloaded from the NASA Ocean Color website (https://oceandata.sci.gsfc.nasa.gov/l3/) from January to December 2024. The Aqua MODIS retrieval algorithm is given below.
log10(chl) = a0 + a1 ∗ x + a2 ∗ x2 + a3 ∗ x3 + a4 ∗x4
where x = log10
2.5 Methodology
The methodology includes two types of Digital Number (DN) value extraction for summarizing statistics within specific buffer zones and polygons from satellite images downloaded using SeaDAS and ArcGIS. The images, obtained from the NASA website, are in NetCDF format. Initially, a buffer zone was generated in ArcGIS as a shapefile representing the Region of Interest (ROI). In this study, six concentric buffer zones were created around the Visakhapatnam fishing harbor and designated ROI with radii of 50 km, 75 km, 100 km, 125 km, 150 km, and 200 km.


2.5.1 Extraction of DN value From Image through SeaDAS
Initially, the downloaded Net CDF file requires to be imported into SeaDAS. To access the file using the File Manager, where a series of folders will be shown. Open “Chlor-a” band in the file manager. Further overlay the ROI, bring in the "ESRI Shapefile" by going to the "Vector" menu. This overlay superimposes the vector shapefile over Chl-a image, as shown in Figure 2. Proceed to “Statistical analysis” in the tool bar. The statistical outputs will be displayed on the screen. This procedure provides a clear and efficient approach tool obtaining statistical data in an ROI through SeaDAS, enabling effective oceanographic data analysis (Alaudin et al., 2024). The entire process is detailed in the flowchart (Figure: 3)
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Figure2: Vector File Super Imposed on CHL-a Image in SeaDAS
Create Region of Interest shape file using ArcGIS
Download L3 Chlorophyll-a images

Load image into SeaDAS
Overlay the ROI, bring in the shapefile by going to the "Vector" menu, then clicking "Import," and selecting "ESRI Shapefile"
Navigate to the "Bands" folder and select the "chlor-a" band
Proceed to the "Analysis" tab in toolbar and choose "Statistics" to obtain summary statistics



















Figure 3: Flowchart of Methodology of SeaDAS
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Figure 4: Flowchart of Methodology of ArcGIS



2.5.2 Extraction of DN value From Image through ArcGIS
In order to obtain Chl-a data from ArcGIS, the image needs to be converted from Net CDF to Geo TIFF, because ArcGIS does not natively support Net CDF files for raster analysis. This conversion is achieved in SeaDAS by importing the Chl-a Net CDF file, opening the "chlor-a" band, going to the "File" menu in the toolbar, and saving the file in
Geo TIFF format. Once the Geo TIFF file is produced, it is then imported into ArcGIS for subsequent analysis. The preprocessing is done by using geoprocessing methods to remove negative values within the raster dataset. To obtain Digital Number (DN) mean values from the CHL-a data, the "Zonal Statistics as Table" tool, under the Geoprocessing menu. The input feature zone data is provided with the ROI shapefile, and the related zone field (e.g., ID) is chosen. The value raster is defined as the pre-processed CHL-a raster. This tool produces different summary statistics such as mean, median, and standard deviation. This approach to acquiring summary statistics is in accordance with accepted standards. The steps outlined in the ArcGIS manual (Esri. 2025) are outlined. The overall process is illustrated in the Figure 4.
2.6 METHODS OF EVALUATION
To evaluate the differences between the mean values extracted using SeaDAS and ArcGIS, the Absolute Percentage Error (APE) was employed as a comparative metric between the two extraction methods. (Khair et al., 2017)
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3. RESULTS AND DISCUSSION
This dataset investigates Chl-a in the coastal waters of Visakhapatnam and comparing the outputs from ArcGIS and SeaDAS across multiple buffer zones ranging 50 km, 75km, 100km, 125km, 150km and 200 km. The analysis of Chl-a data from January to June across various buffer zones (50 km to 200 km) shows consistently minimal discrepancies between the values extracted using SeaDAS and ArcGIS (Table 1). From January to May, the analysis of buffer zones ranging from 50 km to 150 km consistently shows nearly identical mean Chl-a values and equal pixel counts across SeaDAS and ArcGIS, with negligible errors appearing only in the sixth decimal. However, in the 200 km buffer, a recurring one-pixel discrepancy is observed each month. In January, SeaDAS reports 2991 pixels while ArcGIS reports 2992, resulting in an error of -0.000052 and APE of 0.012831. February follows a similar trend, with SeaDAS reporting 3256 pixels and ArcGIS 3257, leading to an error of -0.000060 and an APE of 0.016103. In March, the 200 km buffer shows SeaDAS at 2761 pixels and ArcGIS at 2762, with an error of -0.000041 and an APE of 0.015976. April continues this pattern, with SeaDAS reporting 913 pixels and ArcGIS 914, resulting in an error of -0.000027 and an APE of 0.010183. Finally, in May the 200 km buffer SeaDAS has 3269 pixels and ArcGIS has 3270, yielding an error of -0.000030 and an APE of 0.009857. This consistent one-pixel difference in the 200 km buffer across all months suggests a minor but systematic variation between the two systems. Interestingly, June shows no discrepancies in pixel counts across buffer zones, including the 200 km zone, where both SeaDAS and ArcGIS report 1824 pixels. The error and APE are virtually zero.
	The data from July to December, as shown in Table 2, also reflect overall consistency with minor variations. From July to November, the 50 km to 150 km buffers consistently show equal pixel counts and negligible errors across SeaDAS and ArcGIS analyses. However, the 200 km buffer repeatedly exhibits a one-pixel discrepancy each month in July to November. In July, SeaDAS reports 606 pixels, while ArcGIS reports 605, resulting in an error of -0.002961 and an APE of 0.120614. In August, the 200 km buffer shows in SeaDAS with 2466 pixels and ArcGIS with 2467 pixels, yielding an error of -0.000290 and an APE of 0.029920. September continues this trend, with SeaDAS reporting 3212 pixels and ArcGIS 3213, leading to an error of -0.000097 and an APE of 0.009235. In October, the 200 km buffer has SeaDAS at 3290 pixels and ArcGIS at 3291, resulting in an error of -0.000127 and an APE of 0.015293. In November, SeaDAS reports 2899 pixels and ArcGIS 2900, with an error of -0.000175 and an APE of 0.024291. Smaller buffers maintain negligible variation throughout the period. Finally, December shows no pixel count differences across all buffer zones. The 200 km buffer, like the smaller ones, reports 2602 pixels in both platforms, with an error of 0.000000 and an APE of 0.000001, indicating perfect alignment.


Table 1: Monthly Analysis from January to June
	
	ArcGIS
	SeaDAS
	

	
	Buffer in km
	pixel
	mean
	pixel
	mean
	ERROR
	APE

	January
	50
	194
	0.689104
	194
	0.689104
	0.000000
	0.000003

	
	75
	425
	0.552002
	425
	0.552002
	0.000000
	0.000002

	
	100
	789
	0.461972
	789
	0.461972
	0.000000
	0.000000

	
	125
	1238
	0.456415
	1238
	0.456415
	0.000000
	0.000001

	
	150
	1763
	0.442899
	1763
	0.442900
	-0.000001
	0.000158

	
	200
	2992
	0.405267
	2991
	0.405319
	-0.000052
	0.012831

	Febuaruy
	50
	236
	0.544789
	236
	0.544789
	0.000000
	0.000003

	
	75
	516
	0.472369
	516
	0.472369
	0.000000
	0.000003

	
	100
	898
	0.408618
	898
	0.408619
	-0.000001
	0.000244

	
	125
	1361
	0.409295
	1361
	0.409295
	0.000000
	0.000002

	
	150
	1905
	0.410804
	1905
	0.410804
	0.000000
	0.000001

	
	200
	3257
	0.372685
	3256
	0.372745
	-0.000060
	0.016103

	March
	50
	175
	0.333511
	175
	0.333511
	0.000000
	0.000002

	
	75
	422
	0.288949
	422
	0.288949
	0.000000
	0.000004

	
	100
	754
	0.265268
	754
	0.265268
	0.000000
	0.000001

	
	125
	1171
	0.261180
	1171
	0.261180
	0.000000
	0.000005

	
	150
	1651
	0.261867
	1651
	0.261867
	0.000000
	0.000005

	
	200
	2762
	0.256714
	2761
	0.256755
	-0.000041
	0.015976

	April
	50
	0
	NA
	0
	NA
	NA
	NA

	
	75
	0
	NA
	0
	NA
	NA
	NA

	
	100
	40
	0.213412
	40
	0.213412
	0.000000
	0.000001

	
	125
	202
	0.199983
	202
	0.199983
	0.000000
	0.000000

	
	150
	376
	0.218300
	376
	0.218300
	0.000000
	0.000075

	
	200
	914
	0.265138
	913
	0.265111
	0.000027
	0.010183

	May
	50
	244
	0.391561
	244
	0.391561
	0.000000
	0.000000

	
	75
	524
	0.340930
	524
	0.340930
	0.000000
	0.000004

	
	100
	908
	0.321233
	908
	0.321233
	0.000000
	0.000001

	
	125
	1365
	0.306346
	1365
	0.306346
	0.000000
	0.000000

	
	150
	1903
	0.304439
	1903
	0.304439
	0.000000
	0.000003

	
	200
	3270
	0.304431
	3269
	0.304461
	-0.000030
	0.009857

	June
	50
	194
	1.332947
	194
	1.332947
	0.000000
	0.000001

	
	75
	466
	1.027300
	466
	1.027300
	0.000000
	0.000000

	
	100
	788
	0.871198
	788
	0.871200
	-0.000002
	0.000223

	
	125
	10
	0.746932
	10
	0.746932
	0.000000
	0.000004

	
	150
	1299
	0.722360
	1299
	0.722360
	0.000000
	0.000002

	
	200
	1824
	0.761222
	1824
	0.761222
	0.000000
	0.000001




Table 2:Monthly Analysis from July to December
	 
	 
	ArcGIS
	SeaDAS
	 
	 

	 
	Buffer in km 
	pixel
	mean
	pixel
	mean
	ERROR
	APE

	July
	50
	2
	2.200530
	2
	2.200531
	-0.000001
	0.000043

	
	75
	95
	2.120552
	95
	2.120552
	0.000000
	0.000003

	
	100
	274
	2.682388
	274
	2.682388
	0.000000
	0.000003

	
	125
	416
	2.955889
	416
	2.955889
	0.000000
	0.000000

	
	150
	458
	2.898297
	458
	2.898297
	0.000000
	0.000002

	
	200
	606
	2.455000
	605
	2.457961
	-0.002961
	0.120614

	August
	50
	85
	1.841492
	85
	1.841492
	0.000000
	0.000003

	
	75
	228
	1.429106
	228
	1.429106
	0.000000
	0.000000

	
	100
	476
	1.123547
	476
	1.123547
	0.000000
	0.000004

	
	125
	798
	0.953672
	798
	0.953672
	0.000000
	0.000001

	
	150
	1258
	0.936066
	1258
	0.936066
	0.000000
	0.000003

	
	200
	2467
	0.969200
	2466
	0.969490
	-0.000290
	0.029920

	September
	50
	238
	1.250116
	238
	1.250116
	0.000000
	0.000001

	
	75
	516
	1.194773
	516
	1.194773
	0.000000
	0.000003

	
	100
	886
	1.181148
	886
	1.181148
	0.000000
	0.000004

	
	125
	1339
	1.190650
	1339
	1.190650
	0.000000
	0.000001

	
	150
	1861
	1.099498
	1861
	1.099498
	0.000000
	0.000003

	
	200
	3213
	1.049774
	3212
	1.049871
	-0.000097
	0.009235

	October
	50
	243
	1.041750
	243
	1.041751
	-0.000001
	0.000100

	
	75
	525
	1.021297
	525
	1.021297
	0.000000
	0.000002

	
	100
	909
	0.967953
	909
	0.967953
	0.000000
	0.000003

	
	125
	1376
	0.926415
	1376
	0.926415
	0.000000
	0.000003

	
	150
	1917
	0.921814
	1917
	0.921813
	0.000001
	0.000111

	
	200
	3291
	0.830592
	3290
	0.830719
	-0.000127
	0.015293

	November
	50
	204
	1.414508
	204
	1.414508
	0.000000
	0.000001

	
	75
	456
	1.062706
	456
	1.062706
	0.000000
	0.000001

	
	100
	777
	0.903422
	777
	0.903422
	0.000000
	0.000000

	
	125
	1174
	0.809769
	1174
	0.809769
	0.000000
	0.000003

	
	150
	1654
	0.767007
	1654
	0.767007
	0.000000
	0.000001

	
	200
	2900
	0.720429
	2899
	0.720604
	-0.000175
	0.024291

	December
	50
	225
	1.476354
	225
	1.476354
	0.000000
	0.000000

	
	75
	499
	1.185069
	499
	1.185069
	0.000000
	0.000003

	
	100
	866
	1.029178
	866
	1.029178
	0.000000
	0.000002

	
	125
	1250
	0.946331
	1250
	0.946331
	0.000000
	0.000003

	
	150
	1676
	0.869583
	1676
	0.869583
	0.000000
	0.000001

	
	200
	2602
	0.774657
	2602
	0.774657
	0.000000
	0.000001



The data indicates a monthly fluctuation in the number of valid Chl-a pixels observations (Figure 4). Notably, the highest number of valid pixels was recorded in the months of May, September, and October. In contrast, a noticeable decline in valid pixel count was observed in April and July across all spatial buffers. Remarkably, no valid pixels were detected in the 50 km and 100 km buffers during April. This pattern aligns with findings by Jayaram et al. (2018), who reported 47% to 87% missing data in the Arabian Sea. Similarly, Feng and Hu (2016) highlighted that over 70% of satellite-based ocean color products experience significant data gaps, posing a major challenge for oceanographic studies. Gregg and Rousseaux (2014) attributed such limitations to surface-obscuring features like clouds and aerosols, inter-orbit gaps, and solar illumination constraints. Consistent observations were made by Redfern et al. (2023), who also reported missing pixels in July. Liu et al. (2021) identified data gaps in the northeastern Bay of Bengal during April, which corroborates the current study’s findings. Additionally, a data gap of approximately 50–60% during the monsoon season was noted, which is in agreement with Amzi et al. (2015).Figure 5 : Valid Pixel Number of Chl-a

4. CONCLUSION
This research evaluated SeaDAS and ArcGIS performance for zonal statistics extraction for Chlorophyll-a (Chl-a) analysis of Visakhapatnam coastal waters, Bay of Bengal, January–December 2024 from Aqua-MODIS satellite imagery over buffer zones of 50km, 75km, 100km, 125km, 150km and 200 km. Both programs showed excellent consistency in mean Chl-a values with absolute errors of 0.000027–0.002961 and APE of 0.000001–0.120614. Errors were low across buffers up to 150 km but persistent one-pixel difference at 200 km marginally increased errors, with the highest in July (0.002961) and lowest in June and December (0.000000). SeaDAS as free, open-source software provides higher precision for processing satellite-derived Net CDF data and is thus best suited for researchers prioritizing Chl-a accuracy in oceanographic research. ArcGIS, though involving format conversion from Net CDF to Geo TIFF, provides higher geospatial visualization and multilayer integration and is thus best suited for aggregated marine ecological analysis. For identification of possible fishing grounds in the Bay of Bengal, both programs were found reliable, as errors were far below conventional thresholds for ecological impact. The user would select SeaDAS or ArcGIS depending on their needs: SeaDAS for quick, precise Chl-a processing and ArcGIS for better spatial presentation and analysis. Seasonal data gaps, especially in April and July with reductions in pixel counts of up to 50–80% due to factors like cloud cover, aerosols and sun glint show a serious weakness. Future work should aim to eliminate these gaps, perhaps by multi-sensor integration or advanced gap-filling algorithms, to improve Chl-a precision retrieval in tropical coastal waters and support sustainable fishery management.
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